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Learn how to transform your architectural designs or digital prototypes into immersive presentations for 
effective design reviews or convincing sales presentations. This class will cover tips and tricks to help you 
add realism, creativity, and dynamism to your presentations. 
Learning Objectives 
 

Learning Objectives 
 Learning Objective 1: Manage large size models in Autodesk® Showcase™ 

 Learning Objective 2: Create your own materials and material library 

 Learning Objective 3: Create your own environment from an HDR image 

 Learning Objective 4: Use tips and tricks that will help you work more efficiently with Autodesk® 
Showcase™ 

 

About the Speaker 
Marion Landry has over 16 years of experience in Architectural Visualization, working with a wide range 
of software including Autodesk® 3ds Max® / Autodesk® 3ds Max® Design and Autodesk® Showcase™ 
software. She has worked for various architecture firms in Vancouver, BC and on numerous projects 
from concept design to high-end visualization.  
 
As a Technical Marketing Manager for Autodesk, she focuses on the creation of technical 
demonstrations and workflows with Autodesk® 3ds Max® Design and Autodesk® Showcase™ products. 
She also contributed in the writing of multiple white papers including: Daylight Simulation in 3ds Max 
Design 2009 (Getting started and advance), Using the Autodesk Civil Visualization Extension for 3ds Max 
Design and AutoCAD Civil 3D and more recently Easier mental ray rendering for designs workflows. You 
can follow Marion’s technical advices and tips and tricks publication on her YouTube channel and on 
twitter.  She also answers technical questions and offer supports on The Area Autodesk® Showcase™ 
forum.  

Published papers 
http://images.autodesk.com/adsk/files/3dsmax_started.pdf 
http://images.autodesk.com/adsk/files/3dsmax_advanced.pdf 
http://images.autodesk.com/adsk/files/mental_ray_white_paper_2012_en.pdf  
http://images.autodesk.com/adsk/files/civil_whitepaper.pdf 
You tube channel @LandryMarion 
Twitter #MarionLandry 
Facebook page @ Autodesk Autodesk Showcase 

 @ Marion Landry Art 
The Area Autodesk® Showcase™ Forum http://www.the-area.com/forum/autodesk-showcase/ 
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http://www.youtube.com/user/LandryMarion/videos?flow=grid&view=1
https://www.facebook.com/MarionLandryArt
http://www.the-area.com/forum/autodesk-showcase/
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Tips with to Inventor workflows 

Some challenge exists with the Inventor workflow in terms of file size. Often the Inventor projects are 
quite large with millions of objects (parts). It is suggested to organize your project first in Inventor. 
Below are few suggestions you might want to consider: 

 Consider importing parts of your model first and at a later time, the complete assembly. 

 Clean up your model of unnecessary objects (parts) that you won’t need for the visualization. 
Keep in mind that hidden objects will import as hidden object in Autodesk® Showcase™.  

 Import your objects at a low level of tessellation first in Autodesk® Showcase™. You can always 
increase the level of detail later on in Autodesk® Showcase™. http://youtu.be/ea-nGZDP4Cs 

 Be patient during the import process while Autodesk® Showcase™ tessellates the millions of 
objects included in your scene.  

 

1: Set up your Inventor file first 
It is important to understand your Inventor project in order to understand how your project will be 
imported in Autodesk® Showcase™. Here are few tips to keep in mind. 
 

 If you are planning on exporting Inventor constraints, make sure they are drivable constraints 
first and that they work properly. The exact naming (case sensitive) of each constraint will be 
really important for a successful import in Autodesk® Showcase™. 

 Have a look at your design view representations. The way they are setup will be translated into 
Autodesk® Showcase™ Storyboard slides, shots and alternatives.  Activate the view 
representation you want your model to first appear in Autodesk® Showcase™ before exporting.  

 

2: Importing and working with Inventor constraints 
There are two method of sending Inventor constraints to Autodesk® Showcase™. If you own an 
Autodesk Suite, - Product Design Suite as an example- you can use the Suite Workflow.  (refer to as: one-
click button). If you don’t, you can import the Inventor .iam or .ipt, along with the constraints directly 
into Autodesk® Showcase™.  Let’s review both workflows along with some tips for each: 
  

http://youtu.be/ea-nGZDP4Cs
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2.1:  Suite Workflow> One-click button 
From Inventor, go to the Main menu> Suite workflows. Three options are offered to you: 

 
Depending on the option you choose, the export setup menu will have preselected settings. If you want 
to export Inventor constraints, it is recommended to use the “Showcase Constraint Animation” option.  
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Before you run the export, always check the Settings to make sure they correspond to what you need. 
You can always adjust these settings and override the pre-selection you just made. 

   
1. Geometry: let’s you adjust the level of detail (tessellation of Showcase) 

upon import.  
2. Visual Style: Lets you setup which visual style will be display in the 

Showcase viewport upon import. 
3. Light Style: You can override the Showcase environment you have 

already chosen if you want. It is recommended to leave these settings as 
is and make the adjustment once in Showcase 

4. Object Animation: You will need to have this option turned “on” if you 
plan to import constraints. If this option is turned on, when clicking the 
“Run” button, it will let you select the Inventor constraints. 

 
Click on RUN 
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Navigate to the drivable constraints in your Inventor scene and select it. You can select multiple 
constraints.  
The Showcase Conceptual Model window will list the constraints you have selected. 

 
 
Click “continue” once you have selected all the Inventor constraints you want to import. The 
export/import process will start.  
 
Autodesk® Showcase™ will launch automatically and will import your scene, depending on the scene 
complexity and the level of detail you have selected, the translation process might take a while.  
 
**Review the suite workflow steps in a YouTube video: http://youtu.be/WISYIe71Du8 
**Understand level of details: http://youtu.be/ea-nGZDP4Cs 
  

http://youtu.be/WISYIe71Du8
http://youtu.be/ea-nGZDP4Cs
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2.2: Importing Inventor model and constraints directly from Autodesk® 
Showcase™ 
It is also possible to import Inventor model and constraints directly from Autodesk® Showcase™.  
 
To do so, go to the Autodesk® Showcase™ main menu File>import>Import files… 

 
 
Similarly to the Suite workflow, you will want to verify the import settings first. Browse to the Inventor 
.iam or .ipt file you want to import and click on the “settings” button from the import file(s) window. 
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1-File format: In this case, you want the file format to be (IAM,IPT) files.  
2- Geometry section: Here you will be able to choose the level of detail. Refer to 
video to understand the impact of level of detail for your Showcase projects: 
http://youtu.be/ea-nGZDP4Cs 

 
3-Shots section: This option will create additional Autodesk® Showcase™ shots 
on import. You can choose various shots from the list. 

 
4-Animation section: If you are planning to import Inventor constraints, you will 
need to check the option “create behaviors from constraints” and write the 
name of the Inventor constraint you are importing. It is really important to write 
the EXACT name (case sensitive) as it appears in Inventor (Any spelling mistake 
stop the constraint from being imported.)  I suggest you copy the constraint 
name from Inventor and paste it in this window. Click the plus sign (+) button to 
add more than one constraint. 

 
5-New Scene Lighting Style section: (Not represented in the screen grab- This 
section will only show if you own an Autodesk Suite) Lets you choose the 
Autodesk® Showcase™ environment. I suggest you leave it to the default 
“Empty”. It will be easier to change the environment once you are in Autodesk® 
Showcase™ and received visual feedback of your choice. Leaving it to the 
default it will also help avoid choosing an environment that is not proper for you 
scene (mostly of wrong scale). In this menu, you can also choose where the 
ground plane will be set, for most case scenario, you will want the ground plane 
at the bottom of your model.  

 
Close the setup menu and click import. The Inventor Assembly Settings will open and you will need to 
browse to the Inventor Project file. This will help Autodesk® Showcase™ to find all the Inventor 
component related to the Inventor project.  

 
Click Continue 
 
**Review the import Inventor constraints process from Autodesk® Showcase™ in a YouTube video: 
http://youtu.be/grOHD0l349g 
  

http://youtu.be/ea-nGZDP4Cs
http://youtu.be/grOHD0l349g
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3: Adjusting the level of detail after import 
Tessellation is the process of subdividing a surface into smaller polygons (shapes) for rendering. The 
smaller the polygons, the more accurate the appearance, but the greater the impact on performance.  
 
Levels of Detail (LODs) are the different depths of tessellation that can be used for CAD (computer-aided 
design) models. Typically, LODs vary from low-fidelity (larger polygons, poor surface quality, and high 
rendering speed) to high-fidelity (smaller polygons, excellent surface quality, but may take time to 
render).  
For example, the sphere in the following illustration is displayed, from left to right, with low- to high-
fidelity LODs.  

 
When importing a model in Autodesk® Showcase™, by default, the LOD is set to “All purpose” which is 
set to give great rendering quality model but can impact the performance of Autodesk® Showcase™ 
depending of your computer.  Re-adjusting the level of detail will help you balance the performance vs 
quality of your render. If you are dealing with a very heavy model, it might be a good idea to reduce the 
level of detail for the first import. This will reduce the density of the mesh (tessellation) in Autodesk® 
Showcase™ and therefore the translation(import) time. It will also lighten the scene. You can always 
convert your model to a lower/ higher level of detail after the import process.  
 
 

To re-adjust the level of detail after import, open the Import window by pressing “I” on your keyboard. 
Right click on the conversion setting and choose the appropriate level of detail.  

 
 

**Understand level of detail and how to adjust the LOD after import in this video:  http://youtu.be/ea-
nGZDP4Cs 
 

 

http://youtu.be/ea-nGZDP4Cs
http://youtu.be/ea-nGZDP4Cs
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4: Using the Behaviors (Inventor constraints) in a storyboard slide 
Once you have imported an Inventor constraint to Autodesk® Showcase™, it becomes a Behavior. You 
can access it from the Behavior menu. (“b”on your keyboard)  
 
To play the behavior (constraint), use the playback button on the behavior menu 

  
This menu will control the playback of all behaviors at the same time. 
To play the behavior individually, right click on the behavior icon and choose the option>Unknown 
Controls for nameoftheInventorconstraint 

 
This will open an individual playback from which you can control the behavior individually.  

 
 
Because every constraint animation is different, the way you can use them in your presentation will 
vary. The principle is the same; you need to add the behavior to a storyboard slide and decide how to 
play the behavior. 
 
To add the behavior to a storyboard slide, right click on the behavior icon and choose > Add to 
storyboard slide, and then choose the playback action.  
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According to the nature of your behavior animation, you might want to play forward, backward, 
continue or stop and reset. You can add multiple actions per behavior in each storyboard slide.  
 
You can also choose to change the animation properties of the behavior to play once, in a loop or 
oscillate. 
Right click on the Behavior icon> properties.. 

 
  
**Look at how you can Add Behaviors (Inventor Constraints) into a Storyboard Slide in a YouTube video:  
http://youtu.be/b4tk4meTlEE 
 
 
 
 

http://youtu.be/b4tk4meTlEE
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4: Changing the orientation of your Inventor model once in Autodesk® 
Showcase™ 
 
It is possible for your Inventor model to be wrongly orientated after importing it in Autodesk® 
Showcase™. You first instinct might be to rotate and/or move the object. This is wrong and can cause 
object to behave inappropriately, especially for model with behaviors (constraints). 
 
 The proper way to re-orient the model is within the import window.  
 
Go to the File menu > Import >Import Status or press “I” on your keyboard to open the Import Status 
window.  
From the Import Status window, highlight xxx.iam file (or any other imported file) and right click > 
Model properties 
 
Change original Up-axis to Z-up. This should fix the problem. 

 
 

5: Setting the floor position 
During the import process, according to the setting you have chosen, the environment ground plane 
level will be set at either the bottom of the model or at the level set in the Inventor project. You still 
might want to move the ground plane position. To do so, go to  
 
Main menu Edit>Set Environment floor Position. You can adjust the floor position within this window.  
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*Things to keep in mind! 
 If you have imported a model that include constraint, DO NOT MOVE, ROTATE OR SCALE the 

model once in Autodesk® Showcase™. This will affect the way the behavior will behave.  Instead, 
you can check if you have imported the model in a proper scale (feet-inches-meters) under the 
import status window. Then you can change the scale of the environment to match the model 
size by either going to the environment properties or choose a different environment that is 
more appropriate to your model.  

 

Tips with DWG workflows 
If you own any of the Autodesk Suite that include AutoCAD,  you can load 3D DWG model directly in 
Autodesk® Showcase™ from the one click suite workflow from AutoCAD. Below are few things to keep in 
mind when doing so.  
 

 It  will be easier to manage your Showcase project if you Import multiple DWGs (one per major 
component) 

 On import, Autodesk® Showcase™ will Zoom extended to the entire scene. So if you have a tiny 
object in a far corner of your project that you no longer use, Showcase will include that object in 
the import and zoom extend the view to include the tiny object… So you might want to make 
sure that your DWG is clean of unwanted object before export/import.  

 Keep in mind that Showcase keeps an active link to AutoCAD (as well as Inventor or Revit for 
that matter) You have to possibility of updating your model as the design evolve. Have a look at 
this video created by Jonathan Landeros to understand the principle behind. 
http://www.youtube.com/watch?v=leWnF9xm6sE&feature=share&list=PLD6D46E8F19539A17 

 When using DWGs it is possible that the surface Normals (Orientation of polygonal faces), once 
in Autodesk® Showcase™, might be wrongly oriented. Applied materials will look best when the 
normal are facing towards the viewer. It is suggested to diagnose your model immediately after 
import to fix the normal orientations. To do so, open the Visual Style window (press “v” on your 
keyboard), Open the Diagnostic Tab and choose the Normals style. Every face that is showing in 
yellow towards the camera is wrongly oriented. To switch the normal use the F8 key. Watch this 
video to review these steps: http://youtu.be/eIrRIR4U4HI 

 Keep in mind that the objects that have wrong UV and display improper textures in AutoCAD will 
be the same once imported to Autodesk® Showcase™. Fixing the objects UV in AutoCAD might 
be a challenging job but it is something really easy to fix in Showcase.  The easier work around in 
Showcase is to use Showcase Materials with Try planar mapping type. Review these two videos 
to understand how to use Showcase Materials http://youtu.be/flxxxUCuVGA and 
http://youtu.be/KkED6Ujp_NE 
 
 

1: Adjusting the camera clipping planes 
Often when you are working with large size model or scenes, you will notice a great amount of flickering 
or black triangle effect on your model. The scene will have millions of black flashing triangle and will be 
buzzing when orbiting/navigating around. This is caused by the camera clipping plane distance being too 
short causing difficulties for the camera to identify the order in which to display the polygons or faces. 

http://www.youtube.com/watch?v=leWnF9xm6sE&feature=share&list=PLD6D46E8F19539A17
http://youtu.be/eIrRIR4U4HI
http://youtu.be/flxxxUCuVGA
http://youtu.be/KkED6Ujp_NE
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To fix it, go to file menu>settings>scene settings. From the Scene Settings window, increase the near 
clipping plane distance amount.  The distance amount will depend on the type of scene and the distance 
of the camera from the object it is viewing. So, if you have views that are really close to your objects 
combine with views that are really far from the objects, you will need to find the correct ratio to avoid 
clipping the objects that are close from the camera. 

 
 
**Have a look at this video to understand how to adjust the clipping plane: 
http://youtu.be/PBMMg8PEPzU 
 
 

Tips with to Revit workflows 
Although the data exchange between Revit and Autodesk® Showcase™ is relatively clean, the biggest 
challenge with this workflow is the size of the scenes. Most Revit scenes include millions of objects 
which will take several minutes for Autodesk® Showcase™ to import. Once in Showcase you might have 
a low frame per second (slow refresh rate.)  When dealing with large Revit scene, you will need to be 
creative and think outside the box. Here are few tips that might help you.   
 

 Manage the views in Revit first: It might be a good idea to create specific views that will be 
dedicated to Showcase visualization. You should manage the visibility content of these views to 

http://youtu.be/PBMMg8PEPzU
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include only the necessary objects. By that I mean, if you are not going to see the plumbing or 
electrical objects of your design, make sure they are not visible in your view before exporting 
the FBX file. You can review this video to understand the workflow process: 
http://youtu.be/3cZPMjIAHFY 

 Use multiple FBX: It will be easier in Showcase to manage a complex scene that is built of 
multiple FBX then one large and heavy FBX. For example, let’s think of a typical building with 
furniture-plumbing-lighting fixtures… You might want to export a different FBX for each of these 
groups of objects. Doing so will help you hide and manage content once in Showcase as well as 
use the Group Combine plugin (Next tips) on each individual FBX.  

 Work with the organizer: Using the organizer to manage the content of your scene can greatly 
facilitate your experience. Use the organizer to rename object and help find them easier. 
Combine or separate object or group object in a more efficient way.  

 Clean up the materials list: The least amount of materials in your scene, the faster the frame 
rate. It’s always a good idea to clean up the material list in Showcase. Avoid any duplicated 
materials and minimize the amount of materials in use.  

 

1: Optimized your scene by using AutoGroup Add-Inn  
Large Revit scene can compromise the performance of Autodesk® Showcase™. The display frame rate 
(refresh rate) lag is largely due to the fact that Autodesk® Showcase™ has to refresh a large number of 
objects and materials.  But if you load the AutoGroup Add-in, you can combine and group objects that 
share the same Revit Category, Family, Type and Material which greatly improve the performance of 
Autodesk® Showcase™. 
**Look at how you can optimize your large Revit scene with AutoGroup Add-In in a YouTube video: 
http://youtu.be/g-RadPUCldg 
 

Tips with Materials 
 
1: Create custom Showcase Materials: 
You can easily customize Showcase Materials to your need. Either by using your own textures, colour by 
changing the settings to match the most commonly used materials in your project. It is a good idea to 
save your customized materials to your own library so you can use them from project to project.  
 
To create a custom material, I suggest you start with a Generic Showcase Material.  
Showcase Material offers a long list of customizable settings that will allow you to load your own 
images. Showcase Materials have 4 mapping type giving you flexibility on how you project your texture 
onto an object.   
 
I strongly suggest that you start with pre-built materials that share similar attributes then the material 
you want to create. By doing so, you will save yourself from having to adjust every settings. For example, 
if you need to create chrome that has a particular transparency map, start by using a Showcase Material 
Chrome and only adjust the transparency settings.   
 
 
 

http://youtu.be/3cZPMjIAHFY
http://youtu.be/g-RadPUCldg
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Below, some recommendation for each settings included in a Generic Showcase Material 

 
Colour: 

 
 You can load your own image file. (PNG,JPG,TGA,TIFF,BMP) If your image as an alpha channel, you will 
be able to use it as well in the transparency channel. Keep in mind that to achieve better result, your 
image should be tillable or seamless. Have a look at this video to help you understand what a seamless 
texture means. (http://blog.spiralgraphics.biz/2010/07/what-is-seamless-texture-3d-texture.html) 
 
Reflectivity & highlight: 

 

http://blog.spiralgraphics.biz/2010/07/what-is-seamless-texture-3d-texture.html
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You can load an image as a reflection map. By doing so, you are only affecting the reflection of this 
particular reflection. For overall result of your scene, you might want to consider changing the lighting 
image of your background instead.  Doing so will make every objects in your scene share the same 
custom reflection. By changing the reflection image at the material level, only the objects with this 
material will reflect the custom image.  
 
Transparency: 

 
Black = opaque and white= transparent.  
If you are planning to use your own images for transparency, make sure it is black and white only (no 
colours) Transparency will support shades of grey giving you variation in the transparency level. You 
have the option to invert the transparency texture to have Black = Transparent.  
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Bump: 

 
To have a successful bump relief in your material, you will need to load a normal type image. In 3D 
computer graphics, normal mapping is a technique used for faking the lighting of bumps and dents. It is 
used to add details without using more polygons. A common use of this technique is to greatly enhance 
the appearance and details of a low polygon model by generating a normal map from a high polygon 
model. Normal maps are frequently stored as RGB images where the RGB components correspond to 
the X, Y, and Z coordinates, respectively, of the surface normal. 

 
This is an example of what a normal image should look like. 
 
Mapping Type: 

 
To project custom images unto your objects, you can use 4 types of projection: 
  

http://en.wikipedia.org/wiki/3D_computer_graphics
http://en.wikipedia.org/wiki/3D_computer_graphics
http://en.wikipedia.org/wiki/Polygonal_modeling
http://en.wikipedia.org/wiki/Low_poly
http://en.wikipedia.org/wiki/RGB
http://en.wikipedia.org/wiki/Surface_normal
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Parametric (UV)  
No projection is used. Instead, the image is mapped to the UV coordinates of the surface. Each surface is 
mapped separately, so adjoining surfaces may show seams.  
 

Planar  
The projection of a texture or image as if the images were placed on a level surface and projected onto 
the object. Use this option to apply a texture to one or more surfaces that are relatively flat, such as 
wood paneling.  

 
Triplanar  
The projection of a texture from three perpendicular planes. Use this option for complex surfaces where 
the texture needs to be applied from multiple angles to follow the contours of an object.  

 
 

Cylindrical  
The projection of an image onto an object, as if the image were rolled into a tube and projected inwards 
towards the object. Use this option to apply a texture to the edge of a circular surface, such as a car tire 
tread.  

 
 

Use the projection gizmo by clicking on the move texture button to help you position, scale and rotate 
your image onto your model.  

 +  

**Look at these two videos for a complete review of all the Showcase Material settings:  
http://youtu.be/flxxxUCuVGA 
http://youtu.be/KkED6Ujp_NE 
 

http://youtu.be/flxxxUCuVGA
http://youtu.be/KkED6Ujp_NE
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2: Add Blurred reflection to your Showcase Materials 
New to Autodesk® Showcase™ 2013 is the ability to include and adjust the blurred reflection amount to 
a Showcase material.  
 

 
 

 
Blurred reflection turned off                                Blurred reflection 0.01 
 
**Have a look at this video to understand how to adjust the blurred reflection: 
http://youtu.be/nEj6gYux00Y 
 

3: Reloading the Extended Materials Library 
The extended material library is currently unavailable in Autodesk® Showcase™2013. This affects any 
scene from earlier versions that used extended materials, since the texture files will be missing. (they 
will be showing as black objects in your scene) 
  
To fix the problem users will have to either update the missing textures manually or copy the Extended 
Materials directory to the new 2013 installation location without any XML files in the folder.  
 
For example, copy:  
C:\Program Files\Autodesk\Autodesk® Autodesk® Showcase™™ 2012\support\ExtendedMaterials  
To:  
C:\Program Files\Autodesk\Autodesk® Showcase™ 2013\support\ExtendedMaterials  
Note: XML files in the 2012 folder are not calibrated to work properly with Autodesk® Showcase™ 2013, 
but by copying the textures over, materials will look more complete.  
 

http://youtu.be/nEj6gYux00Y
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If you don’t have Autodesk® Showcase™ 2012 install on your machine, you don’t need to worry about 
the extended material library.  
**Review the complete white paper on migrating older Showcasescene to Autodesk® Showcase™ 2013:  
http://images.autodesk.com/adsk/files/migrating-to-showcase-2013.pdf 
 

4: Save Materials to library   
If you are creating custom materials, might as well save them for future projects. You will also notice 
that you start using the same materials over and over for various project. Why not save them into a 
personal library for a quick access.  
 
Saving materials to library: 
You can save your materials locally to your machine or save them on the network for other co-worker to 
use.  
 
To save your material locally into a “my favorite” folder: Right click on the material you want to add to 
your personal library> Save to Library>My Materials>My Category 

 
By default, Autodesk® Showcase™ created a “My Material” library with “My Category”. You can rename 
the library itself, rename the category, add new category or create a new library all together.  
**you can review this step in this youtube video: http://youtu.be/rT5LkAN050E 
 

5: Share your Material library  
Right click on the Material you want to save to the network library, choose the option> Save to 
Library>New Library 

http://images.autodesk.com/adsk/files/migrating-to-showcase-2013.pdf
http://youtu.be/rT5LkAN050E
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It will open a window that will allow you to browse for a folder. Make a new folder on your network ei: 
Showcase  Materials 
 

 
 
Then it will ask you to create a New Category: Name that category something that is related to the 
material you are saving: ei: Metals2013 or project name 

 
 
A new library should appear in your Material Library list with the category you have created, containing 
the material you are saving. Add as many materials to that library. 
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This library now will always reload with Autodesk® Showcase™ on your local machine unless you remove 
it. Remove it from Autodesk® Showcase™ won’t delete the save folder on your network.  
 If you look under the newly save folder on your network, you should find the following: 

 
A Metal folder containing a materials.adsklib and a xxx.xml companion file 
 
To load the library from a different computer, open the material palette and go to the Material Library 
Manage button and choose>Add Library 

 
Browse to your network and select the new folder you add created. (Not the category folder but the 
main folder with the category folder in it) 

 
The library should appear under the Material Library list 
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**The Autodesk Materials might display a wrong image thumbnail but the material will work properly 
once applied to an object. It is important to name your materials appropriately to help you recognized 
them as the visual thumbnail will be difficult to identify.  
 
You can keep adding material to this library and each user will receive the additional materials upon 
reload of the library or restart of Autodesk® Showcase™.  
 
**you can review this step in this youtube video: http://youtu.be/rT5LkAN050E 
 

Tips for Animation 
1: Import animated camera from 3ds Max Design 
3ds Max Design offers a series of tools to create cinematic like camera animations. If you own a 
Autodesk Design Suite premium, you have access to 3ds Max Design as part of your suite and might 
want to take advantage of its tools. Creating and adjusting camera animation in 3ds Max Design can give 
you more refine animation. You might want to explore the option of creating your camera animation 
within the 3ds Max Design environment and importing these animated cameras to Showcase.  
To do so, you will need to export the animated camera in 3ds Max Design into FBX file and import them 
in Showcase. To learn more about this process, watch this video: 
 
**you can review this step in this youtube video: http://youtu.be/1Sn04kILIsY 
 

2: Import animated objects from 3ds Max Design 
It is also possible to import animated objects into Showcase. Showcase does not support Vertex 

animations, only object based animations such as scale, rotate and or move. As long as your objects 

have been animated using standard key frame animation using a combination of Move, Rotate and 

Scale, they will import successfully in Showcase.  Animating objects in Showcase is possible but can 

prove challenging to refine. Refining your animation in 3ds Max Design is simpler as it is using Bezier 

curve animation tools.  

http://youtu.be/rT5LkAN050E
http://youtu.be/1Sn04kILIsY
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To do so, you will need to export the animated objects in 3ds Max Design into FBX file and import them 
in Showcase. To learn more about this process, watch this video: 
 
**you can review this step in this youtube video: http://youtu.be/yRZwCOJUTdA 

 
Tips with Storyboard 

Aggregating the elements of Showcase into story board slides is like creating a story. So you might want 
to think about that story in advance; 

 What are you trying to tell? 

 What do you want to show first? 

 How do you want to open the presentation? How do you want it to finish? 

 Do you need to show materials and texture at this point or is it too distracting? 

 Do you want your audience to engage in the presentation? 
It is always good to have a storyboard first to make sure you stay on target.  
 
There are many ways to be creative with your presentation and something you might want to consider is 
to include many visual styles. Have a look at this presentation as an example: 
http://youtu.be/fqKz3VbeeoU 

 
This presentation starts with a Flat Colour Visual style and later on migrates to realistic style. It also has 
an animated cross section that reveals the building colours. This is a creative way to use the Showcase 
tool to tell a story.  
 

1: Using different visual style as part of your storyboard presentation 
Unfortunately, visual styles cannot be added to a storyboard slide. When you create a presentation 
(movie) from the storyboard , it will save the movie using the visual style that is currently active in the 

http://youtu.be/yRZwCOJUTdA
http://youtu.be/fqKz3VbeeoU
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viewport.  If you want to include different visual styles in your presentation, you will have to do the 
following: 
 

1. Create a storyboard slide for each visual style. 
2. Load the first visual style: example: toon colour 
3. Render the storyboard slide with this visual style. This will create one movie with Toon colour as 

a visual style 
4. Change the visual style: Example: Realistic 
5. Render the storyboard slide with this visual style. This will create one movie with Realistic as a 

visual style.  
6. If you need, use a software to stitch all the individual movies back into one. (After Effect, Quick 

time Pro, YouTube) 
If you have a software such as After Effect, you can also composite multiple movie on top of each 
other. As an example, wireframe on top of Realistic view. 
 

2: How to animate a Cross Section 

You can easily animate a cross section to reveal or hide sections of your projects. To do so 
1. Create a cross section 
2. Move and rotate the cross section at the initial position of the animation 
3. Open the Behavior menu by pressing “b” on your keyboard 
4. Create a key frame Animation 
5. Save a keyframe for the start position of the cross section and the end position.  
6. Move the cross section to the final location. Save a keyframe for that position. 
7. Play the keyframe animation or add it to the storyboard slide.  

**Have a look at this video to understand how to create an animated cross section: 
http://youtu.be/zeMLhHqH77E 
 

Tips for Ray tracing 
Why use ray tracing over hardware rendering?The main reason is that Ray traced images are higher 
quality and more realistic. Ray tracing produces highly realistic visuals by tracing “rays” from each 
rendered pixel into the 3D scene, which then bounces, bends and creates visual effects similar to real 
light. Ray tracing uses computer processor (CPU) so the number and speed of processors influences the 
performance.  Ray tracing mode can be both interactive or offline for output. 
 
Ray tracing can add many new effects that are impossible to achieve with Hardware rendering: 
-Ray traced reflections and transparency 
-Refraction 
-Absorbance 
-Ray traced shadows 
-Ray traced ambient shadows 
-Global Illumination 
The more obvious one is accurate reflection from other objects in your scene. 
 

http://youtu.be/zeMLhHqH77E
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Ray traced render                                                             Hardware render 
 
Some Autodesk Materials such as Glass and Metals will only render well under ray tracing mode 
For example: 

  
Raytraced Autodesk Material: Clear glazing              Hardware render Autodesk Material: Clear glazing     

                                
Ray traced Autodesk Material: Aluminum                Hardware render Autodesk Material: Aluminum 
 
There are two Ray tracing mode in Autodesk® Showcase™, Interactive and render mode.  
 

1: Interactive performance tips  
Refers to the ray tracing mode in the viewport window 

1. Reduce the Autodesk® Showcase™ window size. Ray tracing is based on tracing rays from each 
pixel of the image, so reducing the number of screen pixels will increase the frame rate and any 
progressive refinement of the image on screen.  

2. In the Options > Selection Display Style menu, select a “wireframe” display method. The 
“animated grid” will prevent progressive refinement.  
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3. Move the view away from areas with lots of transparent and refractive surfaces. Transparent 
and inter-reflective objects will require more rays per pixel than other objects in the scene, and 
will reduce performance when they are dominant in the view. 

2: Ray trace rendering tips 

Refers to rendering with Ray tracing modeI always find it easier to let a render go indefinitely and stop 
it when I am satisfied with the quality. I will often render during breaks, at lunch time or overnight. To 
do so, I normally set the settings that way 

:  
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Then hit the save button from the ray tracing status menu once I am satisfy with the quality level. Upon 

saving your Ray tracing image, an xml file will be saved automatically. The XML file contain screen image 

quality preset (XML file) and can be used to reproduce the exact quality level saved in that image for a 

larger image or animation.  

1. Locate the saved settings XML file on disk. (It is saved in the same location as the screen image, 
with the same name appended with “.xml”)  

2. Move this XML file to the My Documents\Autodesk Showcase 2013\InteractiveRaytracingSettings 
folder.  

3. Close and re-open the Performance and Quality or Publish windows.  

The new preset will be shown in the list of Quality presets in all windows, and can be used to 
recreate the exact quality level.  

**Have a look at this video to review these steps: http://youtu.be/dVcYaXbNMiY 

 
More tips on ray tracing can be found on The Area Showcase forum 
http://www.the-area.com/forum/autodesk-showcase/general/ray-tracing/ 
http://www.the-area.com/forum/autodesk-showcase/general/ray-trace-rendering-
speed/http://www.the-area.com/forum/autodesk-showcase/general/high-quality-raytrace-export-
without-pixeling/ 
 

Tips to help enhance the look of your projects 
 

1: Stop transparent objects from casting shadow: Hardware rendering 
 

By default, all objects are set to cast hardware shadow. Unless you are on Ray tracing mode, Autodesk® 
Showcase™ will not recognize material transparency. 
Have a look at this model for example: 
Some sections of this canopy used glass material 

 
By default, Autodesk® Showcase™ will not recognise the material transparency and will cast shadow 
from the glass like it would be a non-transparent material 

http://youtu.be/dVcYaXbNMiY
http://www.the-area.com/forum/autodesk-showcase/general/ray-tracing/
http://www.the-area.com/forum/autodesk-showcase/general/ray-trace-rendering-speed/
http://www.the-area.com/forum/autodesk-showcase/general/ray-trace-rendering-speed/
http://www.the-area.com/forum/autodesk-showcase/general/high-quality-raytrace-export-without-pixeling/
http://www.the-area.com/forum/autodesk-showcase/general/high-quality-raytrace-export-without-pixeling/
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 The shadow is full with no transparency. 
To work around this while using hardware rendering, you will need to stop the transparent object from 
casting shadows.  
 
To do so go to Appearance menu>Directional Light and Shadows 
In the Directional Light and Shadows menu, go to Shadow Casting for All Environments section and 
change the “Shadows are cast by:” status to  “Specific objects on Ground and Objects” 

 
Select the glass objects and click on the button: Choose Shadow Casters>>> and Select the option Stop 
Selected Object from Casting Shadows. 
 

This will stop the glass objects from casting shadows therefore giving you transparency in your shadow.  
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**you can review this step in this youtube video: http://youtu.be/eONPULRf92E 
 

2: Add resolution to your hardware shadows 

By default, Autodesk® Showcase™ Hardware rendering shadows will be displayed at a resolution of 1024 
x 1024. You can Adjust the resolution of the shadows for greater or fewer details. Depending on your 
hardware and the complexity of your scene, there is a risk of performance degradation at higher 
resolutions.  

 
You may also consider turning the shadow off while working in Showcase. This would increase 
performance. You can turn the shadow back on when you are ready to output final images or 
presentation. 
**you can review this step in this youtube video: http://youtu.be/eONPULRf92E 

http://youtu.be/eONPULRf92E
http://youtu.be/eONPULRf92E
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3: Working with Ambient shadows:  
When ambient shadows are applied to a scene, it looks more realistic. With ambient shadows, corners 
small object as well as object curvature are more realistic and easier to identify. In reality, ambient 
shadow are the result of light occlusion, or the blocking of light from objects by other objects. 
 

  
No ambient shadows                                            Baked ambient shadows 
 

Autodesk® Showcase™ has two types of ambient shadows: 
 
Preview (instant-on) 
Preview ambient shadows are created using Screen-Space Ambient Occlusion (SSAO). SSAO is a 
technique for approximating the effect of baked ambient shadows in real-time. This enables you to turn 
on ambient shadows quickly without having to pre-calculate them. Quality may not be as high as with 
baked ambient shadows, but the effect is instantaneous.  

  
Bake ambient shadows are baked onto a surface by a process of computation of a  shadow 
bitmap. The texture darkens the surface, regardless of which material is later applied to the 
surface. Because ambient shadows have this darkening effect on the look of materials, it is 
recommended you bake the ambient shadows before adjusting the look of materials.  
Bake ambient shadow calculations are by default based on object parameterization. For best 
results, make sure imported objects contain no overlapping vertex parameter values.  



From Ideas to Real-Time Presentation: Tips and Tricks for Autodesk® Showcase™ 2013 

 

32 
 

Before baking ambient shadows, press F7 to make sure that normals are facing outward. (If normals are 
not facing outward, unpredictable results may occur.)  

  
 
The visual style will determine if you are using ambient shadow or not. In most case scenario, you will 
want to have the best visual style in the viewport and therefore select the “both shadows and ambient 
shadows” style. In this case, the type of Ambient Shadow selected will dictate what type is used in the 
viewport. Main menu>Appearance>Ambient Shadows… 

  
  
To adjust the Ambient Shadow look, it is easier to choose it as a visual style. To do so, open the visual 
style panel by pressing “V” on your keyboard. Open the “diagnostic” section and choose “Ambient 
Shadow” 
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Then, open the ambient shadow settings panel by going to Appearance menu>Ambient Shadow… 
If you are to use the Preview style ambient shadows, I suggest you check the Smoothing option for 
better results. 

 
If you are going to bake the ambient shadow, remember that transparent materials such as glass don’t 
have ambient shadows.. so no need to calculate these objects. The calculation of the bake ambient 
shadow can take a while depending on your computer power and the complexity of your scene. I 
suggest you do the baking calculation on coffee break or overnight for a complex scene. Try few objects 
at first to fine tune the settings before you calculate all the objects in your scene.  
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You can always reduce the effect (darkness of the ambient shadow on your object) after you have bake 
the ambient shadow by adjusting the percent of the effect.  
 

4: Creating night scenes 
This is a suggested workflow for night scene: 

1. Choose a night environment: Desert Dawn Road or any custom HDR environment you might 
want to use 

 
2. Adjust the exposure value of the background: Right click on the environment icon and choose> 

Properties. Under the Lighting tab, adjust the Exposure value for light conditions 
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3. Start adding accent lights if you need to: Choose between Spot light or Point light.  

 
 
 

5: Working with Accent Lights 
Accent lights are independent sources of Illumination in your scene. They can be used to create 

highlights, dramatic lighting, or emphasize important parts of your model. Accent lights are object that 

need to be position in your scene. They will also need to be associated with object in order to illuminate. 
They will only cast shadow under the Ray tracing mode.  
 
Autodesk® Showcase™ has two types of Accent Lights: 
Selective Spot light (This light sends one direct light in a triangular shape) and Selective point light (this 
light sends light in all direction in a ball shape). Each light will behave differently.  
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 To create an Accent Light, go to main menu>Appearance>Accent Lights or press L on the keyboard. 
1. Click the create button and choose either a Spot light or Point light.  
2. Associate the light to some objects in your scene. Right click on the light icon and open the 

Properties. Select the objects in your scene that should be affected by the light. Under the 
Accent light properties menu> Associated Object> Choose> Add Selection to 

      
3. Position your light accordingly by either moving it with the Transform handle, using Interactive 

placement, or the Auto placement. 

 
You might want to press Shift+L to view the Accent light Grip. 
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4. Continue on adjusting the various Light properties.  

Remember that accent light will only render shadows under Ray Tracing mode.  

    
Accent lights with hardware rendering mode     Accent lights and Shadow with Ray tracing mode 
**To understand more about accent lights, have a look at this video:  http://youtu.be/vhUhT5_pYSM 

 
6: Creating your own environment from HDR image 
It is possible to create your own environments in Autodesk® Showcase™. There are three different 
approaches: 
 

1. A beginner workflow, which uses a third party HDR with the goal to generate a scene that  
looks decent from any direction, and does not look overly bright dark no matter how you 
navigate around the model. 

2. An Intermediate workflow that creates an environment with a HDR file obtained from a third 
party in order to create realistic renderings. 

3. An Advance workflow were you create an environment where you are actually taking the 
pictures and want to be as physically correct as possible for lighting simulation. 

For this exercise, we will review the beginner workflow but you can always review the white paper that 
explains in great detail how to achieve all three workflows: 
http://images.autodesk.com/adsk/files/showcase-2013-environment-creation.pdf 

http://youtu.be/vhUhT5_pYSM
http://images.autodesk.com/adsk/files/showcase-2013-environment-creation.pdf
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To create a custom environment using the beginner workflow, you will need an HDR image from a third 

party. The maximum recommended size for HDR images are is 4k x 2k. (4096 x 2048 pixel) If larger HDR 

images are applied then Showcase will require 2GB of VRAM min. 

You can find various HDR images online. When using a HDR image, make sure a Lat-long type image. The 
image should look something like this: 

 
 
Once you have the HDR image, follow these steps:  
 

1. Create a generic Environment in Showcase  

 
2. Open the Environment properties and go to the lighting Tab 
3. Load the HDR Image under the Lighting image section. By doing this step, you are loading an 

HDR image that will dictate the lighting condition of your scene. You will not yet see the image 
in the background.  

4. Adjust the Light of the image by choosing the right preset and fine tuning the exposure value 
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5. Click on the Adjust Directional Light and Shadow button to adjust the directional light and 

shadows to match the sun or lights direction of the HDR image.  
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6. Go to the Background tab, Load the same HDR image under the Background image. Unless you 

have a separate image for the ground, leave the Ground image uncheck so the same image is 
used for the background as well. 
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7. Under the Shape and Position section, change the shape, size and rotation accordingly. You 

might also want to open the “Show more details” Section and move the background in its 
proper position 

 
8. For the background image, notice that you can use a variety of image mapping type: 

 
9. Look at the model from different angles and adjust the two light contribution values until the 

model, the background and the shadows look as desired. 
10. Rename the background and reset the thumbnail image by  right clicking on  Generic 

background and choose> Set Image 
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11. Save the new background to library for future use. This way, you can build your own personal 
environment library.  

 
 
**Have a look at this video to understand these steps better: http://youtu.be/ar0VivUjXqI 
 

Publish to cloud tips 
Rendering your images in Showcase is fast and can give you great quality renders, but it doesn’t have to 
stop there! You can always bring your render in a third party software (Photoshop as an example) and 
enhance the images further.  
 
To do so, it is always recommended to save your images as a .TIFF or PNG as both options will give you 
options to save with alpha channel.  Having an image with alpha channel will allow for easy compositing 
such as replacing the environment.  
 
 
 

  

http://youtu.be/ar0VivUjXqI
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** Saving in the hardware mode in 2013 will correctly save the alpha channel (in TIFF), but when in ray-
tracing mode, as you’ve noticed, the alpha is lost.  The work around is to save and image in both mode 
(hardware and Ray traced) and used the alpha channel from the hardware rendering .tiff image.  
 

Compare and Contrast scenes 
If you are planning on presenting your project within the Showcase environment, you might want to 
consider using compare and contrast scene features. (Press C on your keyboard) 
 
The compare scene menu will let you load multiple scenes and switch between them to:  
Evaluate scene files either one at a time or side-by-side using the same lighting conditions.  
Compare current designs, storyboards, previous models, and competition data.  
** It is recommended that you finish setting up all the scenes before you use this feature. While under 
Compare scene, you won’t be able to save your scene.  

1. Save your scene files.  
2. Select Present >Compare Scenes (or press C).  

The Compare Scenes interface appears. An icon is shown for the current scene.  

 
3. Click Add Scene.  
Alternatively you can drag and drop the new scene file onto the Showcase window. You will be 
prompted whether you want to import or Compare the scene file (click Compare).  
Browse to and select the new scene file.  
The new scene appears in the Showcase window. Its icon appears in the Compare Scenes interface.  
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To switch between scenes, click the icons in the Compare Scenes interface.  
An eye icon indicates which scene is active:  

 
4. Use the above instructions to add as many scenes as you need.  
5.  

Once you have loaded a minimum of two scene, you can decide to compare them side-by-side. 
Select Present > Side-by-Side.  
 
The first two scenes are shown side-by-side. The interface switches to presentation mode.  
If you are already in presentation mode, you can also click this button.  
A split view appears, with a different scene shown in each side.  

 
For each side, the active scene in the Compare Scenes interface is shown with the eye icon. The icon for 
the scene on the other side is grayed out.  
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The cameras for both sides are locked, meaning objects in both sides move the same way as you 
navigate around the scene.  
 
You can change the camera angles for both sides by navigating around in either side, by clicking on the 
ViewCube, or by selecting shots, turntables, or alternatives. In all cases, the objects in both sides move 
the same way.  
 
If you have loaded three or more scenes, you can change the scene on either side by clicking on the 
icons in the Compare Scenes interface.  
 
To exit from the side-by-side views:  

 To go back to authoring the scene, press the Tab key.  

 To keep presenting the scene, click this icon on the side of the scene you want to view:  

 
Or go to the compare menu 
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More information  
 

 Facebook Autodesk® Showcase™ 

 Autodesk® Showcase™ Tips and tricks on youtube.com  @LandryMarion 

 Follow me on twitter @MarionLandry  

 The Area- Autodesk® Showcase™ forum  

 Use the HELP button!! 
 

https://www.facebook.com/Autodesk.Showcase
http://www.youtube.com/landrymarion
•%09http:/www.the-area.com/forum/autodesk-Autodesk®%20Showcase™/

